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Introduction 
Whether you are working with students or professionals with or without disabilities it is 

important to include some images of computer or screen based activities in the training 

material you develop. 

Adding Alt Text and captions to images is key to the accessibility of your training material 

as is the use of contextual links and footnotes or endnotes to show the entire web 

addresses. This level of accessibility is documented in my books on logical document 

structure and general document accessibility.  

The purpose of this document is to provide an overview of the tools you have on the 

Windows based computer system that let you create images from the computer screen for 

your training material and to then make those images accessible in your Word documents. 

These tools include: 

 The Print Screen button on your keyboard. 

 The Windows Snipping Tool. 

 The Screen Clipping Tool in Microsoft OneNote. 

 The Paint program to save your images in PNG format. 

Keep in mind that copying images directly into documents increases the file size 

substantially. It also means that you don't have an archive of images to work with. Trying to 

remember what document you copied an image into gets tiring.  

Keep in mind that copying images directly into documents may increase the file size 

substantially. It also means that you don't have an archive of images to work with. Trying to 

remember what document you copied an image into gets tiring.  



Creating Pictures with Print Screen 
A tool that has been around as long as we've had keyboards is the Print Screen key on the 

keyboard. Typically it is located with the Scroll Lock and Pause buttons and this group of 

three keys is usually set aside from other groups of keys on the keyboard. 

 

Figure 1 Diagram of a standard keyboard. 

The preceding image is from the Web by Design Introduction to Windows 95 web page1. 

In figure 1 the Print Screen key is in the group of three keys just above the "six pack" that 

has the Insert, Delete, Home, End, Page Up and Page Down keys. It is the key on the left of 

the group of three. 

 

Figure 2 Close up of the Print Screen key. 

The preceding image was taken from the diagram of the keyboard on the Web by Design 

Introduction to Windows 95 web page2. 

                                                        
1 Web by Design Introduction to Windows 95 web page: 
http://www.iupui.edu/~webtrain/tutorials/win_95_intro.html  
2 Web by Design Introduction to Windows 95 web page: 
http://www.iupui.edu/~webtrain/tutorials/win_95_intro.html  

http://www.iupui.edu/~webtrain/tutorials/win_95_intro.html
http://www.iupui.edu/~webtrain/tutorials/win_95_intro.html
http://www.iupui.edu/~webtrain/tutorials/win_95_intro.html
http://www.iupui.edu/~webtrain/tutorials/win_95_intro.html
http://www.iupui.edu/~webtrain/tutorials/win_95_intro.html


If you press the Print Screen key on its own you will put an image of the application that is 

open on the Windows Clipboard. You can then copy it to other places such as a Word 

document or Paint. 

 

Figure 3 Image of this document in Word 2013. 

If you press Alt + Print Screen you will put an image of the specific element with focus on 

the Windows Clipboard. This can be a dialog showing more granular information. You can 

then copy it to other places such as a Word document or Paint. 



 

Figure 4 Image of Paragraph dialog in Word. 

This keyboard command lets you take elements of the computer screen and use them as 

images in your training material. The Snipping Tool and Screen Clippings Tool let you take 

pieces of the computer screen to create close-up views of elements of the screen or 

application. 



 

Figure 5 Close-up of the first options in the Line and Page Break tab of the Paragraph dialog. 

Let's look at how to do this. Once we understand how to get the images we will look at 

creating image files in Paint. 

Creating Pictures with Snipping Tool and Screen 

Clippings 
There are two “built-in” tools that can be used to create a single image from a group of 

objects or images. One is found in the Windows 8 operating system, and the other is found 

in Microsoft OneNote (all versions).  

This topic provides the steps for using both.  Both of these tools are mouse dependent 

activities. 

Windows Snipping Tool 
This is a great tool for taking parts or "snips" of what is on the screen. 

 

Figure 6 Snipping Tool app from the Windows Start Screen. 

You might want to put this item in the Taskbar, Start Screen or on the Desktop as an icon so 

it is easy to find. 

To launch the Windows Snipping Tool: 



1. Press Windows key to Show the Start Screen. 

2. Start typing Snipping Tool in and the edit box will open so you can continue 

searching. 

3. The Snipping Tool should be the first item found. 

4. Press Enter on it to launch it. 

5. When the Snipping Tool launches, the desktop screen “dims” and you are ready to 

use the mouse to outline the part of the screen you want to use as an image. 

 

Figure 7 Snipping Tool dialog. 

There are some options in the Snipping Tool dialog and they are accessible using the 

keyboard. 

 

Figure 8 Options for a new screen snipping. 

If you choose “Freeform Snip” you had better have steady hands. This turns your cursor 

into a pair of scissors and you can literally draw a freeform snipping. 

The first thing you’ll notice when using the Snipping Tool is that any choice you make dims 

the screen so you can then select what part you want to snip. 

AS you click the left mouse button and make your selection, the dimness goes away. 



 

Figure 9 Snipping Tool ready to snip a piece of the desktop. 

When you begin drawing the boundary around the content you want, the Snipping Tool 

dialog disappears and you can snip whatever you want. If the Snipping Tool is blocking 

what you want to snip, simply move it out of your way and snag the snip. 

Once you draw the boundary around the content on the screen you want to snip, a larger 

dialog opens in the Snipping Tool and you have some options. In the main area is the 

snipping you snagged. 



 

Figure 10 Freeform snipping of part of the Paragraph dialog. 

You can save the snipping, send it to someone by e-mail (both of which can be done 

through the File Menu) or use the Pen, Highlight and Eraser tools. 

The following image shows the tools in the Toolbar accessed through the File Menu. 

 

Figure 11 File Menu options in the Snipping Tool once you have a snipping. 

  



To snag a screen Snipping: 

1. Use either the Toolbar or the File Menu to choose the type of snipping you want. 

2. Your mouse pointer turns into scissors. 

3. If you choose “Rectangle” drag the scissors diagonally from upper left to lower right 

to create the rectangular snipping. 

a. If you chose Freeform Snipping, you can just draw the boundary around 

whatever you want to snag on the screen.  

b. If you choose “Window Screen” you will be able to snip a dialog separate 

from its background application by clicking on it. 

c. If you choose Full Screen, you will snip the entire screen. This is similar to 

using the Print Screen button on the keyboard. 

4. Once you select the area of the screen you want to create the image from and let go 

of the mouse button, the Snipping Tool window opens and the “snip” is displayed. 

The Snipping Tool uses the Windows Clipboard to display and copy content to. 

 

Figure 12 Rectangular snipping of the Word Paragraph dialog in the Snipping Tool. 



Whatever choice you make in terms of a screen snipping, it will remain checked in the 

Snipping Tool until you change it. 

While the image is in the Snipping Tool window, you can add information to it. Unlike 

laying arrows or circles on images as other objects or layers, when the modified image is 

copied to an application such as Adobe Fireworks, Adobe Photoshop or Paint, the 

additional information is there too.  This is also true if you copy the image from the 

Snipping Tool into a Word document. 

 

Figure 13 Screen snipping with Office Button circled. 

The preceding image shows part of the Word Paragraph dialog with one line Highlighted in 

yellow and one item circled in blue. With practice, these types of additions will be less 

awkward looking. You can also do this on a tablet computer with a pen instead of on a 

desktop computer with a mouse…or add a tablet style pen to your desktop computer for 

working with images. 

There are options for the Snipping Tool. Almost all of them are selected by default. The 

exception is to hide the text instructions for the Snipping Tool. 



 

Figure 14 Snipping Tool Options dialog. 

The colour of the outline of the “snip” can also be changed from red to one of the other 

colours in the palette. I’ve chosen to have my snips outlined in blue.  You can choose to 

have the snipping outline show with the snip in the Snipping Tool dialog and to “move with 

the image.” 



 

Figure 15 Snipping of screen shown in Snipping tool. 

Before I do anything with the snipping in the Snipping Tool dialog, while the image is still 

on the Windows Clipboard, I can copy it into my Word document and the blue outline 

comes with it if I’ve chosen to show the outline once the snipping is snagged. For my 

documents, I use the Picture Styles in Word but if you don’t and you want to be able to 

distinguish the image of a low contrast snipping and the document itself, this is a good way 

to do it. There are other colour choices in the Snipping Tool Options dialog. 

 

Figure 16 Border of Snipping Tool snip changed to blue for segment of Paragraph dialog. 

The snipping can be saved directly from the Snipping Tool by choosing File, Save as. 

By using the Snipping Tool to create a single image from grouped objects, the individual 

pieces of the grouped object will not be identified as images with no Alt Text when the 

document is converted to tagged PDF or when someone using a screen reader comes across 



them in your document and you will not have to ad Alt Text to every piece of the set of 

grouped objects. Nor will you have to arrange the grouped objects into a logical Tab Order. 

You will just have to add one piece of Alt Text to the single image. 

Add Snipping Tool to the Start Screen 
You can add the Snipping tool to the Windows 8.1 Start Screen or the Taskbar by right 

clicking on it while you are in the search results and choosing either of those options. You 

can also use the AppKey to perform this function. 

 

Figure 17 Options from the Search Results context menu to put the Snipping Tool on the Start Screen or 
Taskbar. 



OneNote Screen Clippings 
Microsoft OneNote is a free form writing tool that has many interesting applications for 

both academic and business environments. One of the most useful tools within OneNote is 

the ability to create “screen clippings” from any content on the screen. In this example, four 

pictures were added to a PowerPoint slide and the OneNote screen clipping tool was used 

to create one single image. 

 

Figure 18 Single image taken from PowerPoint slide using OneNote Screen Clippings. 

 The first thing to do once you launch Microsoft OneNote is to go to Tools, Options and the 

“Display” category. Make sure that the option to place the OneNote icon in the taskbar is 

checked. This will let you create images of the screen as you need them without having to 

launch OneNote. 



 

Figure 19 OneNote 2013 Options dialog showing setting to place icon in System Tray. 

There are settings that allow you to choose where you send the clippings. They are found in 

the “Send to OneNote” category in the OneNote Options dialog. 

If you are creating a lot of Screen Clippings you might want to just have those kept on the 

Windows Clipboard. 

In my settings, I’ve left sending Screen Clippings and information to OneNote at the default 

of “always ask me where to put the OneNote item” except for the last one. 

I’ve chosen to have Screen Clippings only sent to the Windows Clipboard. 

This means that once I use a Screen Clipping it will be on the Windows Clipboard until I 

copy something else to the Windows Clipboard. 



 

Figure 20 Send to OneNote options. 

To use the OneNote screen clipping tool: 

1. Press Windows key + Shift +S. 

2. The screen “dims.” 

3. Use the mouse to select an area of the screen by holding down the left mouse button 

and dragging diagonally until you have the content you want selected. 

4. When the mouse button is released, OneNote opens and the screen clipping is on its 

own “Side Note.” 

5. Select the screen clipping (not the associated text). 

6. Right mouse click on the plus sign to the left of the screen clipping and choose Cut. 

7. Switch to your image editing software such as Paint and create a new image. 

8. Press Ctrl + V to paste the screen clipping into your imaging software. 

9. Save the image in the file format you want. 



 

Figure 21 Send to OneNote dialog for Screen Clipping. 

If you haven’t chosen to put Screen Clippings on the Windows Clipboard, you will get a 

dialog each time you create a Screen Clipping that asks you where you want to put the 

Screen Clipping. This is handy if you are working with OneNote Folders, Sections or Pages 

and are compiling information. In the preceding image I’ve chosen to put them in the Karen 

Folders. 



 

Figure 22 Screen Clipping in a new Page in a new Section of an OneNote Folder. 

You can either keep this image on the OneNote Page or delete it  

If you want to delete the entire page, the fastest way to delete the page is to press Ctrl + 

Shift + A and then the Delete key. This selects the entire page and then deletes it. 

If you activate the OneNote icon in the Taskbar, a small dialog opens with some options. 

There is a keyboard command to do this. Press Windows key + N to open the OneNote 

dialog. 

  



From here the options are to: 

 Press S for Screen Clipping. 

 Press D for Send to OneNote. 

 Press N for New side Note. 

You can exit the OneNote dialog by pressing Alt + F4. 

 

Figure 23 Send to OneNote dialog from Taskbar icon. 

Even if you choose to send the Screen Clipping to OneNote, your image is also on the 

Windows Clipboard and can be copied directly into Word or Paint or another imaging 

software program such as Adobe Fireworks or Adobe Photoshop. The Screen Clipping Tool 

is just the mechanism for putting it there. 



Creating One Image our of Many 
One of the advantages of using the Snipping Tool or Screen Clippings is that we can create a 

single image composed of many shapes or pictures. This is an important technique, 

especially for grouped objects, shapes and SmartArt graphics. 

The following image is an example of how three pictures can be placed on a blank 

background using the Snipping Tool or Screen Clippings to snag them. By using this 

technique, I only have to add one piece of Alt Text. In this case the images are decorative 

and being able to have all of the decorative images gathered together with one piece of Alt 

Text makes it easier to read the document. The document author doesn’t have to figure out 

how to place the pictures and the person using a screen reader or Text-to-Speech tool only 

has to hear “decorative image” once. 

 

Figure 24 Series of pictures of Karen's cats. 

For the samples I’ve created I used a blank PowerPoint slide. If you want to add colour to 

the collage, use a complimentary background for the images. 



 

Figure 25 Series of images of Karen's cats with a background colour. 

The same technique can be used to make one image out of grouped objects, shapes or 

SmartArt, making it more accessible. The following is an example of this technique. 

 

Figure 26 Sample SmartArt graphic as image. 

For complex grouped objects or shapes, there is often not an Alt Text tool for things like the 

“arrow connector” or lines between shapes or objects. Even within SmartArt there are 

components of a SmartArt graphic that cannot have Alt text applied to them. In many cases 



being able to understand the relationship between the shapes and grouped objects is key to 

understanding why they are in a document or on a slide. 

While you can add Alt Text to the global SmartArt or Grouped object container, pressing the 

tab key moves you through those objects piece by piece. The Alt text for the larger pieces is 

read but since the smaller pieces can’t have Alt Text, it is easy to get lost in the details of the 

grouped objects or SmartArt. 

 

Figure 27 Grouped objects/shapes saved as single image. 

While the preceding image appears to be a dog’s breakfast of shapes and connectors, it is 

possible that for someone “designing” it, it has meaning. Given that the connectors cannot 

have Alt text that is read to adaptive technology, the most accessible solution to these types 

of “charts” and diagrams is to create a single image and add the Alt Text. 

Dealing with Complex Images 
One strategy I use for either Word or PDF documents where there are complex images is to 

create either an attachment to the PDF document with the longer more detailed description 

of the diagram or, in the case of word, I add the longer, more detailed description as an 

Appendix at the end of the document. 



The Alt Text for the image then becomes something like “A detailed description of this 

diagram is attached to this PDF document as “filename.” 

I could have put this topic under Alt text and Captions but since we are looking at a diagram 

created out of shapes and connectors, it seems appropriate to add it here. 

A good example of this is the how to tutorial on to using tables for design layout where I’ve 

attached sample documents for people to explore. 

 

Figure 28 Sample showing files attached to a PDF document. 

In the main document, under each corresponding topic, I let people know that there is a 

sample document attached, 

I was once asked if sending people to a website with the documents was a better solution. 

First, if I can’t find what I need when I need or want it, I am not going to go looking on a 

complex website for it. Odds are that the links won’t be contextual or meaningful. 

Second, I may not have access to the Internet and therefore can’t access the documents 

when I need or want to use them. 

Having everything in one place, one file, let’s me have optimal access to the content of the 

main document. 

The attachments can be accessed using the keyboard, opened and either closed again or 

saved to someplace else if security permissions allow. 

Attaching the documents is the last think I do before applying security. 

Using either the attach documents feature in Acrobat or the ability to create an appendix in 

Word provides optimal access and accessibility for everyone. 

Here is a sample case of what I mean. I worked on a Visio organizational chart with lots of 

acronyms. The acronyms began to all sound the same and I soon lost track of where I was 

in the process of applying and appealing something. I took the description of the Visio 



document and expanded all the acronyms in the document. I attached the file to the PDF 

document. Even people without disabilities accessed that Word document with the detailed 

description and I heard comments such as “I never realized what the process was until I 

was able to read all the acronyms. This makes more sense than the diagram.” 

It is an example of how optimizing content for access and accessibility helps everyone 

understand the content of your documents better. 

In this example, any additional information travels with the document and people don’t 

have to spend time searching for it or depending on an Internet connection to be able to 

read it. 

  



Using Paint to save Images 
Whether you are using Print Screen, the Snipping Tool or the Screen Clippings Tool, you 

can paste the image into Paint and save it as a PNG file and add circles or arrows or other 

symbols to it. 

Paint comes with the Windows operating system. 

To launch Paint: 

1. Press the Windows key. 

2. In the Search edit box type Paint. 

3. It should be the first item found. 

4. Press Enter to open the Paint Application. 

 

Figure 29 Paint app with new Paint project canvas. 

The white area is the canvas and the canvas can extend to the entire document area of the 

application Window. You will need to keep an eye on the size of the canvas relative to the 

size of your image. We'll work through this to demonstrate. 

If we look at the image of the Word application Window that was used earlier in this 

document, we can walk through the process of creating a PNG image. You can create a JPG 

or GIF but PNG is now pretty much the standard for creating images that can be used in 

both documents on and on web pages. 



The first thing I am going to do is press Print Screen to snag the PowerPoint application 

Window. I have a blank presentation using the Expedition Theme on the screen. 

I used the Print Screen key to snag the image. 

I then switch to Paint and paste the image into the Paint "document." 

 

Figure 30 PowerPoint user interface in Paint. 

The image appears quite large so I chose View and Zoom Out so that I could see the entire 

image. 

The keyboard commands to do this are: 

 Alt + V, letter I for Zoom In. 

 Alt + V, letter O for Zoom Out. 

 Alt + V, M for 100%. 

 



 

Figure 31 Zoom reduced size of image on Paint canvas. 

I need to be able to see the entire image so that if I need to remove any surrounding white 

pieces of the canvas, I can use the mouse to do so. If you have white pieces of the canvas 

showing, it will be saved as part of the image. This creates unbalanced images or images 

that you can't size effectively in a document. 

Choose File, Save As and expand the Save As menu to show the ability to save the picture as 

a PNG file. 



 

Figure 32 Save as PNG option from Paint File menu. 

The keyboard command is Alt + F, A, P for File, Save as, PNG. The Save As dialog opens. 

I usually create a file folder in My Pictures or Pictures for the project I am working on. For 

example in this case I created a Create Images folder to put the images in. For this 

document and in the future if I need images related to the creation of images, they are all 

there ready to use. 

Now I need to isolate the Paragraph dialog and create an image of it. In this case it is the 

Lines and Page breaks part of the dialog that I am teaching. This is not the tab that opens by 

default so if you are following along, don't panic. 

I use Alt + Print Screen to get this image. 



 

Figure 33 Paragraph dialog in Paint program. 

In this case the image is smaller than the canvas. If I were to save this image now and had 

to resize it in a document, the Paragraph dialog would not be visible in a way that it could 

be seen. 

So I need to remove some of the canvas. 

To remove some of the canvas from an image in Paint: 

1. Click on one of the edges of the canvas. 

2. You will see small handles that change to a double arrow when you hover the mouse 

over them. 

3. Click on one of the handles while you have the double arrow and drag it toward the 

image. 

4. Stop when you are at the edge of the image. 



 

Figure 34 Word dialog in Paint. 

5. You can now go to View and Zoom in to see the image clearly. 

6. You may have to zoom out again to adjust the bottom edge of the canvas. 



 

Figure 35 Zoomed in view of Word Paragraph dialog in Paint. 

You can now save the image and when it is inserted into a document, you will only have the 

Paragraph dialog [in this case] as the image. 



 

Figure 36 Paragraph dialog in Word. 

So far we've shown someone where the Paragraph dialog appears on the screen and what it 

looks like close up. Now we can create images that focus on specific parts of the dialog. 

Note: When we resized the canvas, it will stay at that size when you create 

a new “document” until you resize it again. 



 

Figure 37 Resized canvas in new Paint document. 

To create the new image of a piece of the Paragraph dialog you can use two methods: 

1. Use the Snipping Tool or the Screen Clippings Tool when you aren't going to have an 

image of the larger dialog or application Window. 

2. Use the ability in Paint to cut a piece of the image out and make a new image of it if 

you don't have access to the Snipping Tool or the Screen Clipping Tool. 

To create an image from the Snipping Tool or the Screen Clipping Tool: 

1. Snag the piece of the screen you want. In this example it is the first set of options in 

the Paragraph Line and Page Breaks dialog. 

2. Switch to Paint and paste the image. 

3. Resize the canvas as necessary. 

4. Save the image as a PNG file. 



 

Figure 38 Part of the Word Paragraph dialog in Paint. 

You can now insert the image into a document. 

 

Figure 39 Same image of piece of Word Paragraph dialog in this document. 

To create an image of a piece of an existing image in Paint: 

1. Open the image you want to take the piece from. In this case it is the Paragraph 

dialog image. I've also zoomed in to make it larger. 

2. From the Home Ribbon choose Select and then Rectangular Selection. 



 

Figure 40 Rectangular Selection option from Selection button. 

3. Use the mouse to drag diagonally across the image to choose what you need. In this 

case I'm going to select different options from the previous example. 

 

Figure 41 Section of Paragraph dialog identified to be removed from image. 

4. Press Ctrl + X to cut the piece of the image out of the larger image. 

5. Press Ctrl + N to create a new image. 

6. Do not save the changes to the image when you close it. We want to keep the entire 

Paragraph dialog image for use later if we need it. 



 

Figure 42 Paragraph dialog image with piece cut out of it. 

7. Once the new canvas opens, press Ctrl + V to paste the piece of the image into the 

new image document. 

8. Make any adjustments to the canvas as needed. 

9. Save the new image as a PNG. 

 

Figure 43 New image cut from Paragraph dialog. 

That's it! 

You now have several different ways to create images for your training material. When 

working with Word, use Insert, Picture. Locate the folder you put the picture into and then 

insert it into your document at the cursor point. The keyboard command is Alt + N, P then 

Shift + Tab twice to get to the list of folders and files. 



Making Pictures Accessible 
Now that we have images in our Word document we need to ensure that people with 

disabilities who are using screen readers or TTS/Text-to-Speech software can identify 

them. Imagine being able to read the text but not know what an image is other than by 

hearing "graphic" followed by the dimensions of the image or "slash" followed by the 

dimensions of the image[which is what you hear sometimes in Microsoft Word when you 

come across an image using a screen reader.]. 

By adding Alt Text and captions you optimize the accessibility of your training material. 

It is OK to have the Alt Text and caption be the same text. The reason I have both is again to 

optimize the accessibility of the document. Accessibility is not only related to accessing the 

content digitally. If an any document is printed on paper, will people with learning, 

cognitive or visual disabilities have access to a “description” of images? 

I don’t know of any paper that lets me hover my finger over an image and show the Alt text. 

If someone has low toner in their printer or has a learning, cognitive or visual disability or 

the image is complex, providing a Caption with the image increases the level of accessibility 

of the content. 

Note: Alt Text cannot be read by screen readers in the same way that 

regular text is. We can read all of the Alt Text or none of it. We can't 

always explore it or read it character by character or word by word. 

Ensuring that Alt text is concise and meaningful is key to an 

understanding of the image or object. 

Adding Alt Text in Word 
It is easy to add Alt Text to images and objects in Word, PowerPoint or Excel and a good 

habit to get into. Alt Text should be brief and meaningful. What do you need to know about 

this picture if you can't see it? Images in general should only be used to support content 

and not to decorate pages. 

To add Alt text to an image in Word: 

1. Select the image. 

2. Press the AppKey to open the context menu. 

3. Choose Format Picture and press Enter. The keyboard command is letter O. 

4. The Format Picture Pane opens to the right of the document. 

5. Your focus is in the Format Picture Pane. 

6. Your focus is on the Effects tab. 

7. Press Shift + Tab to move up one level and then Right Arrow to Layout Options. 

8. Press Tab to move into Layout Options. 



9. Press the Down Arrow to Alt Text and then press Enter. 

10. The options for Alt text open. 

11. Tab to the Description edit area. 

12. Generally I don’t add Title text to an image. 

13. Type in the Alt text for the image. 

a. You can select the text and use Ctrl + C to copy it and use it for the caption if 

you want. 

14. Close the Format Picture Pane by pressing Ctrl + Spacebar, C for the context menu, 

Close. 

 

Figure 44 Context menu showing Format Picture option. 

As someone who uses the keyboard instead of the mouse, and someone who uses a screen 

reader, I always close the Format Picture Pane when I’ve finished working on one image. 

The reason for this is that it likes to steal focus from my adaptive technology and I can 

inadvertently end up back in the Format Picture Pane when I didn’t want to be there. 

For those using the mouse, if you are not using multiple monitors, your screen can easily 

become cluttered with open panes that are either on top of each other or beside each other 

making it difficult to both find them when you want and use them effectively with the open 

document. 



This is a suggested technique and you will find your own way of working with the Panes in 

Office applications. 

 

Figure 45 Layout options in Format Picture Pane with Alt text area showing. 

Once the Alt text is entered, with the image still selected we'll add the caption. 

Null Alt text in Word 
Word is a word processor and as a word processor has no concept of decorative images. 

Using the HTML based technique for identifying decorative images does not work in word 

documents. Period. 

When you add the “ “or “” these quotes are read to the person using adaptive technology. 

When you convert the document to tagged PDF, this is the Alt text that will be heard by 

people using adaptive technology. In Acrobat the decorative images will have to be made 

Artifacts. Word also has no concept of Artifact. Neither does PowerPoint or Excel. 

Adopting the use of this technique in an environment that has no concept of a “null 

attribute” creates a barrier to accessibility. 

The attribute is rendered as “graphic, quote quote.” This is meaningless and expecting 

someone using adaptive technology to include an understanding of a null attribute 

whenever they read a Word document is not reasonable and is not inclusive or universal 

design. 



Avoid using techniques from other document format guidelines in programs and authoring 

tools where they simply don’t have an equivalent and therefore don’t work and create 

accessibility barriers. 

Adding a Caption to an image 
If someone's printer creates a poor copy of an image or if the image is complex and 

confusing to someone with a visual, learning or cognitive disability, having images 

captioned comes in handy and optimizes the accessibility of your documents. 

To add a caption in Word 2007: 

1. Select the image. 

2. Press the AppKey to open the Context menu. 

3. Choose Insert Caption. The keyboard command is N for picture Captions in Word.  

a. There is a different keyboard command for table Captions. 

4. This opens a dialog where you can either type or paste in caption text. 

5. The figure and its number will be entered automatically. 

 

Figure 46 Picture context menu showing Insert Caption. 

If you add the Alt text first, the image will be selected and you will save a step when you 

add the Caption. If you add the Caption first, you will need to select the image again to add 

the Alt Text. 



 

Figure 47 Insert Caption dialog with text for Caption. 

By default the Caption is placed below the image. If you are adding a Caption to a table, it 

should go above the table to let people know what they can expect when they enter the 

table. Of course, as a document author, you can choose to have Captions for images show 

above the image for the same reason. 

Tables and equations should also be captioned. You should be able to use the knowledge 

from this document to provide captions for tables and equations. Be sure to change the 

caption label to either Table or Equation. 

Have fun creating images, adding them to your documents and making them accessible for 

people with disabilities who are using adaptive technology! 

 



Appendix A: Other Snipping Tool Options 
The following two images show the two options for the Snipping Tool: one is Windows 

Screen and the other is Full Screen. 

 

Figure 48 Window snipping sample from Snipping Tool 

The difference between the two options is that the Windows Snipping lets you snip a dialog 

while the Full Screen snipping snags the entire screen. 



 

Figure 49 Full Screen sample for Snipping Tool. 



Contact Information 
You can contact Karen McCall with any questions about this how to booklet or any 

suggestions for others. Visit the Karlen Communications web site for more how to booklets! 

mailto:info@karlencommunications.com?subject=Conference%20Handout%20on%20Accessible%20Office%20Documents%202015
http://www.karlencommunications.com/
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